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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

MM7150 Motion Module PICtailTM Plus Evaluation Board (#AC243007) with the 

Explorer 16 development board (#DM240001) to run the demo and sample code. Items 

discussed in this chapter include:

� Document Layout

� Audience

� Reference Documents

� Glossary

� The Microchip Web Site

� Development Systems Customer Change Notification Service

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MM7150-PICTAIL with Explorer 16 

Development Board to perform the demo and modify sample code. The manual layout 

is as follows:

� Chapter 1. “Hardware Setup” – Provides hardware setting information.

� Chapter 2. “Software/Firmware Setup” – Provides software and firmware set-

ting and build information.

� Chapter 3. “Demo Setup” – Includes demonstration procedures.

� Chapter 4. “Troubleshooting” – Provides troubleshooting information.

� Appendix A. “Code Structure” – Provides sample code structure information.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.
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� Appendix B. “Reference Schematic & Bill of Materials” – Provides 

MM7150-PICTAIL adapter reference schematic & bill of materials information.

� Appendix C. “Extension Cable for Explorer 16” – Provides signals connection 

information for building a custom extension cable to use with MM7150-PICTAIL.

AUDIENCE

This document is written for developers who are familiar with 9-axis motion sensor 

applications. The purpose of this document is to describe the functions and use of the 

MM7150-PICTAIL with Explorer 16 Development Board to perform the demos and 

modify sample code functions as described in the Host API Design for MM7150 Appli-

cation Note. 

REFERENCE DOCUMENTS

� DS00001885A - MM7150 Motion Coprocessor Data Sheet

� DS00001888A - MM7150 Motion Module Data Sheet

� DS00001873A - Host API Design for MM7150 Motion Module Application Note

GLOSSARY

This section describes glossary terms and acronyms used in this document.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

Note: Please contact your Microchip representative for the above documents and 

availability.

TERM DEFINITION

EVB Evaluation Board

HID Human Interface Device

I2C Inter-Integrated Circuit

USB Universal Serial Bus

EC Embedded Controller

SF Sensor Fusion
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 

assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 

object linker); and all MPLAB librarians (including MPLIB object librarian).

� Emulators – The latest information on Microchip in-circuit emulators.This 

includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

� In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 

express.

� MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM simulator, as well as general editing and debugging features.

� Programmers – The latest information on Microchip programmers. These include 

production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 

ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 

are nonproduction development programmers such as PICSTART Plus and 

PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 

http://www.microchip.com/support



Preface

 2014 - 2015 Microchip Technology Inc. DS50002322C-page 9

DOCUMENT REVISION HISTORY

Revision Correction

DS500002322C (07-02-15) � Added section 3.2 “Calibrating Sensors”

� Added section 3.5.2 “Flash Configuration Update” feature

� Added Appendix C “Extension Cable” info

� Updated all pictures with latest production MM7150-PICTAIL

� Updated all figures for sample code v1.3.3

DS50002322B (02-18-15) � Added section 3.4 for Sleep/Wake feature

� Added section 3.5 for Flash Update feature, update corresponding 

sections

� Changed UART baud rate from custom 125000 to standard 19200

� Updated all the figures to show the v1.3.2 sample code

� Updated the correct Document Numbers in the Reference Section

� Added section 1.1 for hardware requirements

� Added section 2.1 for software/firmware requirements

� Section 3.2 “Calibrating Sensors” removed

DS50002322A (11-07-14) Initial Release
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Chapter 1.  Hardware Setup

1.1 HARDWARE REQUIREMENTS

� Microchip Explorer 16 Development Board

� Microchip MM7150-PICtail Motion Module PICtail Board

� Microchip PICKit3 or ICD3 or RealICE debugger

� Null-Modem Serial Cable

� USB-to-Serial Adapter

1.2 PREPARING THE EXPLORER 16 DEVELOPMENT BOARD

� Insert PIM PIC24FJ128GA010 at Explorer 16 U1A socket

� Insert strap J7 for PIC24

� S2 switch selected for PIM

� Connect MPLAB ICD3 (or REAL ICE) In-Circuit Debugger module from HOST PC 

to JP1

� Connect USB-to-Serial Adapter capable of 19200 baud rate from HOST USB Port 

to Explorer 16 P1 

- USB-to-Serial Adapter such as Microchip MCP2200 USB to RS232 Demo 

Board (Microchip part#: MCP2200EV-VCP)

� Power Supply (+9V) at J12

1.3 HARDWARE CONNECTIONS FOR MM7150-PICTAIL TO EXPLORER 16 
DEVELOPMENT BOARD

1.3.1 Direct Plug-In

The MM7150-PICTAIL can be installed directly into the Explorer 16 Board. Insert the 

MM7150-PICTAIL into the PICtail™ header J5 with pin 1 of the module lining up with 

pin 1 of the header, as seen in Figure 1-1.

Note: Configure Terminal Emulation Software (ex. Tera Term) for 19200 baud, 8 

bits, No Parity, 1 Stop Bit, No Flow Control.

Note: Before attempting to connect the MM7150-PICTAIL with PICtail™ Plus 

Edge connector module to the Explorer 16 board, it is crucial that the power 

supply to the Explorer 16 be disconnected. Failure to do so may damage 

the MM7150 Motion Module.
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1.3.2 Using Extension Cable

The MM7150-PICTAIL motion module can be connected to the Explorer 16 develop-

ment board via a custom extension cable. Using an extension cable will allow freedom 

of movement compared with directly inserting the MM7150-PICTAIL board into the 

PICtail header on the Explorer 16 board. 

Please see Appendix C. “Extension Cable for Explorer 16” for more information.

FIGURE 1-1: DIRECT CONNECTION OF MM7150-PICTAIL TO THE EXPLORER 16 PICTAIL™ 

HEADER.
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Chapter 2.  Software/Firmware Setup

2.1 SOFTWARE/FIRMWARE REQUIREMENTS

� Microchip MPLABX IDE v2.06 or later

� Microchip XC16 Compiler v1.24 or later 

� MM7150_Exp16_Sample_Code_v1.3.3

� SSC7150 Motion Coprocessor Firmware Binary

- The firmware can be updated using the flash update feature as described in 

Section 3.5.1 “Flash Update command”.

- The firmware binary object code is encrypted and the update process is 

secured.

� MM7150 Module Configuration Firmware Binary

- The configuration data can be updated using the update feature as described 

in Section 3.5.2 “Flash Configuration Update Command”.

2.2 MPLABX PROJECT:

� Start MPLABX IDE as shown in Figure 2-1.

FIGURE 2-1: MPLABX IDE STARTUP SCREEN

� File->Open Project Navigate to project directory and select Open Project as 

shown in Figure 2-2.

Note: The latest sample code is available at www.microchip.com/motion or 

please contact your Microchip representative for more information.

Note: The latest firmware binary file is available at www.microchip.com/motion or 

please contact your Microchip representative for more information.
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FIGURE 2-2: OPEN PROJECT

� Motion Demo Project Loaded as shown in Figure 2-3:

FIGURE 2-3: PROJECT IS OPENED
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� With Explorer 16 power applied, make the project and download to Explorer 16 

flash as shown in Figure 2-4:

FIGURE 2-4: SELECT DOWNLOAD OPTION

� Output screen during build process as shown in Figure 2-5:

FIGURE 2-5: BUILD PROCESS OUTPUT
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Chapter 3.  Demo Setup

3.1 RUNNING THE MOTION DEMO

Once the program has been built and downloaded/programmed successfully to 

Explorer 16 Flash, the user should observe a sequence of LED flashes on the Explorer 

16 board’s LED panel.

The user should then observe the following message on the Explorer 16 board’s LCD 

screen:

MM7150 Demo v133

Select mode:

Additionally the following message will appear in the serial terminal window on the con-

nected computer:

Microchip Motion Module Demo: MM7150 + Explorer 16 Board v1.3.3

Select mode:

Once this message has been displayed, the user can begin navigating the user menu 

using the Explorer 16 push buttons (S3/S6/S5/S4). The buttons are coded as follows:

Note: Using a debugger will necessitate cycling power to the connected 

MM7150-PICTAIL to reset its onboard EC (embedded controller). The eas-

iest way to accomplish this while debugging code is to remove/install power 

to the Explorer 16 Development board with the MM7150-PICTAIL installed 

in J5 header. DO NOT attempt to unplug the MM7150-PICTAIL while power 

is applied to it through its connection to the Explorer 16 Development 

board. This can cause a power spike to the MM7150-PICTAIL and cause it 

to become inoperative.
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FIGURE 3-1: MM7150-PICTAIL ON EXP16 OVERVIEW

As the UP/DOWN buttons are pressed, the Explorer 16 LCD screen will refresh and 

change the position of the selection cursor (“>") to a list of available sensor types. The 

output to the serial monitor will also change to indicate the current sensor type which 

can be selected by pressing the (S5) SELECT button. Once the user selects a sensor 

from the menu, the sensor data output will be displayed and updated on both the LCD 

and serial monitor.

3.2 CALIBRATING SENSORS 

In order for the sensors to function properly and indicate accurate data the user will 

need to calibrate the MM7150 each time power has been removed. This calibration is 

done by selecting the “Calibration” mode as shown in Figure 3-2, holding the 

MM7150-PICTAIL which is attached via an extension cable (see Appendix 

C. “Extension Cable for Explorer 16” for more information), or if not using an extension 

cable, by holding the entire Explorer 16 board with MM7150-PICTAIL installed, and 

moving it through space a few times (~ 5 seconds) to make an “infinity” symbol or a 

“figure 8”.
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FIGURE 3-2: CALIBRATION MODE

3.3 SENSOR DATA DISPLAY

Once calibrated the active sensors on the MM7150 motion module will send updates 

to the PIC24 on the Explorer 16 board running the application program via I2C in the 

form of HID packets including all relevant dimensions of data to be retrieved from the 

device. These sensor readings will be displayed on the LCD (as well as the COM port 

in a ‘linear’ formatting):

1D data: 79.0           

3D data: X: 50.3 Y: 75.6 Z: -32.9

4D data: X: 1.021 Y:-.642 Z:-.458 W: .348

Sample output to COM port running Tera Term serial emulator:

FIGURE 3-3: DISPLAY INCLINOMETER DATA

Note: Significant digits will vary based on resolution of specific sensor. This reso-

lution can be determined by the unit exponent scaling factor. Serial data will 

always be displayed to 3 significant digits.
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The sensor data is updated to the display every time a data register has changed since 

the previous update.

3.4 SLEEP/WAKE

The MM7150 motion module can be set to enter deep sleep to achieve its lowest power 

consumption. In the Explorer 16 sample code this can be accomplished by selecting 

the SLEEP command from the main menu. The Explorer 16 host will send a POW-

ER_OFF command through the I2C interface. As a result of this SLEEP command the 

MM7150 motion coprocessor is halted and the I2C interface is stopped.

Select the WAKE command from the Explorer 16 main menu to wake the MM7150 

motion module. This command will toggle the HOST_TO_SH_WAKE signal to alert the 

MM7150 to wake, send the POWER_ON command via I2C interface, and wait the 

required time to allow the MM7150 to fully wake and allow sensor activity to resume. 

The sleep/wake process requires that certain timing constraints must be observed 

(shown below in Figure 3-1).

3.5 FLASH UPDATE

The MM7150 motion module firmware can be updated with the appropriate binary 

image (please refer to Section 2.1 “Software/Firmware requirements” for more informa-

tion) by selecting Flash Update from the Explorer 16 main menu. The Explorer 16 sam-

ple code will reset the MM7150 module into a state able to accept the new binary 

image, download and CRC-check a valid binary image, program new MM7150 firm-

ware binary via I2C interface, and finally perform image verification.

TABLE 3-1: SLEEP / WAKE TIMING CONSTRAINTS

Delay period Reason

1 Required delay between sending the SLEEP 

command & toggling WAKE

70ms This is required for the coefficient write 

in flash during D3 plus other house-

keeping activities to go into D3 state

2 Required delay between toggling (3 µs min) the 

wake signal and sending power ON command

11ms This is required for clock source 

switching after coming out of D3 state

3 Required delay between D3 wake and enumer-

ation sequence start

30ms This is required for sensor initialization 

after D3 state

Note: The Explorer 16’s UART connection will be used to download the flash 

update binary and, as such, must be connected to a HOST PC running a 

terminal emulator (such as Tera Term as described in 

Section 1.2 “Preparing the Explorer 16 Development Board”).
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3.5.1 Flash Update command

Figure 3-4 shows the Flash Update Command from the Exp 16 sample code select 

menu. 

Select “File->Send file…” from Tera Term utility (NOTE: Select Binary Option).

FIGURE 3-4: FLASH UPDATE COMMAND

FIGURE 3-5: SELECT BINARY FILE
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Following successful completion of the flash update procedure (or if any error is 

encountered), the Explorer 16 must be power cycled.

FIGURE 3-6: DOWNLOADING BINARY IMAGE

FIGURE 3-7: FLASH UPDATE SUCCESSFUL COMPLETION
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3.5.2 Flash Configuration Update Command

The X/Y/Z orientation of the MM7150 module on the customer’s design can be modified 

and saved to the MM7150’s flash. The default orientation of the A/M/G sensors of 

MM7150 (placed horizontally) is:

For this case, the inputs to the motion algorithm (running in MM7150 firmware) can be 

represented by the following 3x3 matrix (Accelerometer for example):

Matrix[3, 3] = [A00, A01, A02; A10, A11, A12; A20, A21, A22];

where Axx could be 0, 1, or -1.

So, for the horizontal orientation shown above and assuming that X/Y/Z are data read 

from the hardware sensor and X’/Y’/Z’ are data input to the motion algorithm:

X’ = A00*x + A01*y + A02*z

Y’ = A10*x + A11*y + A12*z

Z’ = A20*x + A21*y + A22*z

Since the input matrix corresponds one to one in X/Y/Z to the output matrix, we obtain 

the following:

X’ = 1*x + 0*y + 0*z

Y’ = 0*x + 1*y + 0*z

Z’ = 0*x + 0*y + 1*z

i.e. Resulting matrix[3, 3] = [1,0,0; 0,1,0; 0,0,1;]
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This orientation configuration data must be sent to the appropriate sector in the 

MM7150 firmware in the following format:

TABLE 3-2: CONFIGURATION DATA FORMAT FOR HORIZONTAL

Note 1: Check sum will be calculated by the sample code flash configuration 

update command, as a result this field will be ignored and can be: 

00000000.

For example, the XYZ matrix result for the accelerometer (acc_matrix) takes the form 

of:

ACC_matrix = 01 00 00 (X=1,0,0) 00 01 00 (Y=0,1,0) 00 00 01 (Z=0,0,1)

For MM7150_Exp16_Sample_Code_v1.3.3, the flash configuration data needs to be in 

the following binary file format (derived from the above text file):

Name Values

Header A5A5A5A5

Serial_num 00000000

ACC_matrix 010000000100000001

MAG_matrix 010000000100000001

GYR_matrix 010000000100000001

Reserved 00

ACC_config 01010110

MAG_config 02010112

GYR_config 03010168

Reserved 04010144

Reserved 05010177

Reserved 06000000

Reserved 07000000

Reserved 08000000

Reserved 09000000

Reserved 0A000000

Chk_sum 23040000 (see Note 1)

Padded FF’s for 128 byte packet

FIGURE 3-8: CONFIGURATION DATA BINARY FOR HORIZONTAL
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Similarly, for the A/M/G sensors of the MM7150 placed vertically (such as when 

plugged into the Explorer 16 card):

For the vertical orientation shown above and assuming that X/Y/Z are data read from 

the hardware sensor and X’/Y’/Z’ are data input to the motion algorithm with respect to 

the default X/Y/Z settings:

X’ = A00*x + A01*y + A02*z

Y’ = A10*x + A11*y + A12*z

Z’ = A20*x + A21*y + A22*z

Since, for this case, the input matrix does not correspond one to one in X/Y/Z to the 

output matrix, we obtain the following translations:

X’ = 1*x + 0*y + 0*z

Y’ = 0*x + 0*y - 1*z

Z’ = 0*x + 1*y + 0*z

i.e. Resulting matrix[3, 3] = [1,0,0; 0,0,-1; 0,1,0;]
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This vertical configuration data can be sent to the appropriate sector in the MM7150 

firmware in the following format:

TABLE 3-3: CONFIGURATION DATA FORMAT FOR VERTICAL

For MM7150_Exp16_Sample_Code_v1.3.3 the flash configuration data must adhere 

to the following binary file format:

Name Values

Header A5A5A5A5

Serial_num 00000000

ACC_matrix 0100000000FF000100

MAG_matrix 0100000000FF000100

GYR_matrix 0100000000FF000100

Reserved 00

ACC_config 01010110

MAG_config 02010112

GYR_config 03010168

Reserved 04010144

Reserved 05010177

Reserved 06000000

Reserved 07000000

Reserved 08000000

Reserved 09000000

Reserved 0A000000

Chk_sum 1D070000 (see Note 1)

Padded FF’s for 128 byte package

FIGURE 3-9: CONFIGURATION DATA BINARY FOR VERTICAL
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Using the sample code’s Flash Configuration Update mode:

Select “File->Send file...” from TeraTerm utility: (NOTE: Select Binary Option).

FIGURE 3-10: FLASH CONFIGURATION DATA MODE

 

FIGURE 3-11: SELECT BINARY FILE
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